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Introduction

This document describes a Xilinx Zynq Processor System (PS) integrated with Programmable Logic (PL)
peripherals that have been implemented using the Vivado® Design Suite. The target hardware platform
is the Avnet ZedBoard.

This reference design provides a Linux-ready FPGA platform and non-0S (bare metal) software projects
to exercise and validate the following blocks:

1. Processor System

2. HDMI Video and Audio Output

3. DDR Memory

4. 1°C Peripherals

The design includes additional components in the PS and PL needed to boot and execute a Linux kernel
with extensions for Ubuntu (open source). The ADV7511 HDMI Transmitter from Analog Devices is
interfaced to the PS via IP blocks provided by ADI, for both Linux and bare metal operation.

For those wishing to build and run Ubuntu software on this platform, consult the Avnet Ubuntu on
Zynq®-7000 All Programmable SoC Tutorial, which describes in detail all the software steps needed.
However, this bare metal design provides a functional starting point for any system that requires HDMI
video and audio, with or without an operating system.

Objectives

This reference design will demonstrate how to do the following:

e Validate your Development Kit setup by running the demonstration files booted from an SD card.

e Create and build the Vivado Design Suite project from source, and export the hardware platform to
an SDK project.

e Use the SDK to:
e Import and build software to test the HDMI video and audio
e Load the Programmable Logic in the Xilinx SoC via JTAG or SD card

e Execute the software to produce HDMI video and audio using the Analog Devices (ADI) ADV7511
transmitter
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Reference Design Requirements

Software

The software requirements for this reference design are:

Xilinx SDK 2013.4
Cypress CY7C64225 USB-to-UART Bridge Driver
0 See Cypress CY7C64225 USB-to-UART Setup Guide at:
0 http://www.zedboard.org/documentation/1521
Serial terminal emulation software such as Tera Term
0 http://en.sourceforge.jp/projects/ttssh2

Optional - Xilinx Vivado® Design Suite 2013.4 (includes SDK)

Hardware

The hardware requirements for this reference design are:

64-bit host computer with at least 1.3 GB RAM (typical) and up to 1.9 GB RAM (peak) for Windows-7
or Linux operating systems available to Vivado Design Suite (XC7Z020 device)
0 http://www.xilinx.com/design-tools/vivado/memory.htm#zyng-7000

Avnet ZedBoard Development Kit
O 2 USB-A to USB-micro B cables
e USB UART —included in the kit
e ITAG (not required for SD demo)
0 12v Power supply —included in the kit
0 SD card —included in kit

HDMI cable
HDMI-Capable Monitor
0 HDMI-to-DVI adapter may be necessary if the monitor does not have an HDMI port
O (Optional) For HDMI audio, sink device must be HDMlI-audio capable. Not all monitors
equipped with speakers use an HDMI source for audio output.
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Supplied Files

The following directory structure is included with this reference design. These “golden” files can be
used to validate the operation of your board and external connections. See the section “Running the
Demos” for details.

ZedBoard_HDMI_Vivado2013_4.pdf: This document.

boot_source: Contains the files to create the boot.bin images required to boot from the SD card:
system_top.bit: The bitstream for the Vivado hardware design.
vHDMl.elf: Executable file for the bare metal HDMI application for Vivado.
zynq_fsbl.elf: The ARM executable for the Zynq FSBL.

sd_card: Contains the files to run test programs from the SD card:
vHDMI_boot.bin: Executes the bare metal HDMI A/V test.

SDK_project_archive
zed_hdmi_sdk_ws.zip: Software project archive to import to the Xilinx SDK.

vivado:
library: Source files for the library IP used in the hardware platform.
projects: Source files for the HDMI hardware project for Vivado Design Suite.
built.tcl: Tcl script to create and build the hardware platform from the Vivado Tcl Shell.!

The archive can be decompressed anywhere on your system, as long as there are no spaces in the
pathname, as the Xilinx tools do not parse spaces. For the purposes of this document, it is assumed
that the archive has been unzipped to the folder:

C:\ZedBoard_v2013_4\HDMI
Wherever this path is specified, substitute your own installation path.
Caution: When choosing your own path in Windows, use caution in the path length as all files in the

project hierarchy must fit within the Windows OS limitation of 260 characters. See
http://www.xilinx.com/support/answers/52787.html.

! Alternately, the source files may be downloaded from Github and the hardware platform built using the Vivado
Design Suite GUI. Instructions for downloading and building in this mode can be found at:
https://github.com/analogdevicesinc/hdl
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Setting up the ZedBoard Development Kit

Refer to the following figure and perform the steps to set up the board for running the bare metal
applications from the SD card, or via JTAG download.

1. Connect 12 V power supply to ZedBoard barrel jack (J20).

J20 J9

LD13

JP6

LD12

Figure 1 - ZedBoard Jumper Locations

2. Connect the USB-UART port of the ZedBoard (J14), labeled UART, to a PC using the Micro-USB
cable.

3. Use Windows Explorer to copy vHDMI_boot.bin from the Supplied Files to the top level of the
SD card. Rename the file to boot.bin.

4. Insert the SD card into the ZedBoard SD card slot (J12) located on the underside of the PCB.

5. Insert jumper on J18 2V5 to select 2.5V for Vadj.

%AVNETQ 5 June 5, 2014
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6. To boot from the SD card, set the ZedBoard boot mode (JP7-JP11) and MIOO (JP6) jumpers to SD
card mode (shown in the Figure above). To boot from JTAG, set the boot mode jumpers to JTAG

mode:
SD Card Boot Mode JTAG Boot Mode
JP11: SIG - GND JP11: SIG - GND
JP10: SIG-3V3 JP10: SIG-GND
JP9: SIG- 3Vv3 JP9: SIG- GND
JP8: SIG- GND JP8: SIG- GND
JP7: SIG- GND JP7: SIG- GND
JP6: Rev B or C: CLOSED JP6: Don't care
Rev D: Don't Care

Figure 2 — Mode Jumper Settings
7. Connect an HDMI cable between the HDMI sink device and the J9 connector on the ZedBoard.

8. Turn power switch (SW8) to the ON position. ZedBoard will power on and the Green Power
Good LED (LD13) should illuminate.

9. The PC may pop-up a dialog box asking for driver installation.

ZedBoard has a USB-UART bridge based on the Cypress CY7C64225 chipset. Use of this feature
requires that a USB driver be installed on your Host PC. If the host PC requested driver
installation, refer to the Cypress CY7C64225 USB-to-UART Setup Guide in the Reference Design
Requirements section for instructions. When driver installation is complete, continue to the
next step.

_——:—____AVNET 6 June 5, 2014
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10. Wait approximately 15 seconds. The blue Done LED (LD12) should illuminate. Use the Windows
Device Manager to determine the COM Port.

Pind -
=, Device Managet

File Action View Help
= |HEldmE 8 R
a5 USHOMOON

b % Batteries

» M Computer

» - | CypressUsbConsoleWindowsDriver
= Disk drives

B Display adapters
> -4 DVD/CD-ROM drives
» L IDE ATA/ATAPI controllers
b @ IEEE 1394 Bus host controllers
b -5 Imaging devices
b - Jungo
» 2= Keyboards
b Pl Mice and other pointing devices
B Monitors
4.8 Metwork adapters
i Cisco Systems VPN Adapter for 64-bit Windows
Intel(R) 82579LM Gigabit Network Connection
Intel(R) Centrino(R) Advanced-M 6205
L¥ VMware Virtual Ethernet Adapter for VMnetl
H LY Vhware Virtual Ethemet Adapter for VMnet8
4-7% Ports (COM &LPT)
i L Cypress Serial (COM13)
JZ Intel(R) Active Management Technology - SOL (COM3)
» ]2} Processors
b -1 Security Devices
b % Sound, video and game controllers
» {8 System devices

§ Universal Serial Bus controllers

Figure 3 — Device Manager Showing Enumerated USB-UART

Note: Each unique USB-UART device attached will enumerate under the next available COM
port. Here in this example, the Cypress CY7C64225 USB-UART device is enumerated as COM13.

Installing a Serial Console on a Windows 7 Host

Starting with Windows 7, Microsoft no longer includes the HyperTerminal terminal emulator software.
However, this example design requires use of terminal emulation software for a serial console

connection to the target. A suitable free and open-source replacement for HyperTerminal is TeraTerm.
Download and install instructions for TeraTerm can be found at:

http://en.sourceforge.jp/projects/ttssh2.

As an alternative the Terminal applet in the Xilinx SDK may also be used.
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Running the Demo Using the SD Card

You must have the hardware set up and connected as described in Setting up the ZedBoard
Development Kit. Be sure to set the boot mode jumpers to SD card mode as shown in Figure 2 —
Mode Jumper Settings.

If you have not already done so, copy the vHDMI_boot.bin from the Supplied Files to the top level of
the SD card. The card must already have a formatted FAT32 partition with read/write access from
Windows to do this.

Rename this file on the SD card to boot.bin. This is because boot mechanism used by the Zyng-7000 All
Programmable SoC looks for this specific file name on the boot media.

After you have completed this operation, you may insert the SD card into the card cage. Power the
board and AFTER the blue DONE LED illuminates, start your serial console connected to the COM port
selected by the USB-UART driver with communication parameters of 115200,n,8,1. Depending on how
long it took you to establish the serial console, you may need to press the PS-RST button on the board
to repeat the boot procedure and view the serial output.

Expected results on the serial console are shown below:

ADI HDHMI Transmitter Application Yer R1.1.1
HOMI-TH: ADVIS11 Rev Bx12
Created: Dec & 2013 At 17:10:12

To change the video resolution press:
"B - GhDxEBD; 1 - BOOKGO0; 2" - 1024x768; '3' - 1280x720
"E'o- 1360x768; 'S - 1600x900; ‘6" - 1920x1080.
Mute audio and video.
. Driver Enable
HPD changed to HI
HSEN changed to HI
A new EDID segment was read.
VI device.
————————————————————————— EDID BLOCK B =========——mmmeee e
Edid Version 1.3
Mon Timing:

Pixel clock = 148.50 MHz
1928

H Active =
Y Active = 1080
Progressive
No stereo
Separate sync = 3
+ye YSunc
+ya HSunc
Mon Serial: T1V133426372
Mon Freq:
Hin V Freq = 50 Hz
Max V Freq = 75 Hz
Min H Freq = 24 KHz

Hax H Freq = 82 KHz
Mon Name:  VA2451 SERIES
Fdid extensions blocks: @
HHHHHHHHH IR RS EDTD END WHUHHHHEH R

APP: Changed svstem mode to Transmitter
"Un—mute audio and video.

Figure 4 — HDMI Test Serial Console Output

’ The PS-RST operation works as described on ZedBoard Rev D and above. For ZedBoard Rev B and Rev C, once the
persistent Cypress driver has established its initial COM connection, you can power-cycle the board instead.
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The HDMI test will send a video signal to your HDMI sink device at the resolution selected on
your serial console. By default, the application will attempt the highest compatible resolution
supported by the device, as determined from the EDID information.

If your HDMI display has the ability to process HDMI audio signals, you will also hear a rapid
clicking sound from the speakers or headphones attached to the display. Note that at the time
of writing there are no bare metal audio drivers for the ADAU1761 codec connected to the on-
board jacks. To provide audio signals through the jacks, you must use a Linux distribution that
includes the Advanced Linux Audio Support (ALSA) package, such as Ubuntu.

XILINX Em £ XILINX. EﬁEﬁm % XILINX [:nm

% XlLINX DDEV.CES T XILINX. I ANOR2S £ XILINX. []%

YN DIERE Xinx + Analog £s Miirw + Analog Devices L Milirnx + Analog Devic

£ XILINX [ANALOG & xiLINX. [ ANMOS € XILINX [IHEVICES

Figure 5 - HDMI Video at Default (High) Resolution
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You may change the resolution by entering a single digit 0 through 6 in the serial console. Entering 2 for
the connected HDMI sink shown in the example above results in a resolution of 1024x720.

XILINX bEheRs Xilinx + Analog Devices XILINX oGS Xilin

g g s 3 o g
Ligrus P sty

5 AN DY ANALOG £ XILINDG
XILINX. oSS Xilinx + Analog Devices XILINX, : [ > [oavri

=

Figure 6 — HDMI Video at Low Resolution
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Linux Ready Hardware Platform

In order to design the processor-based hardware system, we must first consider the requirements of the
software that will be executing on it. Our ultimate goal, beyond simply using HDMI in a bare metal
environment, is to execute a Linux kernel which in turn will load a file system containing all the elements
necessary to create an interactive Ubuntu desktop display in High Definition.

This statement implies that our processor system will need to include:

o DDR Memory: a full-featured open source embedded Linux kernel capable of executing all the
applications and services associated with Linux cannot be accommodated on-chip, so a
connection to external memory must be provided.

e Ethernet: an Ubuntu desktop environment makes extensive use of the Internet, so we need
the Linux kernel to configure a network connection and to obtain an IP address automatically.
This means an Ethernet MAC and PHY must be included in our hardware list. For production
purposes, a unique MAC address for each device must be defined at the time of manufacture.

e USB Host: interaction with the Ubuntu desktop can be performed primarily through a standard
mouse and keyboard, both of which require a USB connection. Linux supports these devices
with its own USB stack in software, but we must be able to access USB PHY in the design.

e UART: to monitor the boot process of the hardware after power up, we will need a console
separate from the HDMI display. Access to the console information is made via a serial
connection, so our system needs a UART connection.

e 12C: our system has requirements for HDMI output and stereo audio input and output. The
ZedBoard target has both an HDMI transmitter (Analog Devices ADV7511) and an audio codec
(Analog Devices ADAU1761), and both of these chips are controlled via an I°C interface. To
properly configure the chips from software, the processor must be able to connect to an I°C
interface.

e SD: The Ubuntu RFS will be located on an external SD card. This allows flexibility in preparing
the file system outside of our embedded platform, and provides solid-state persistent storage
that will save the environment between power cycles. In order for the Linux kernel to read the
SD card, an interface to the processor must be included.

e Timer: Linux operates more efficiently when access to a hardware timer is provided. This is
more accurate and portable than a software timer alone.

e Quad SPI Flash: This reference design can be modified to utilize QSPI flash in place of the SD to
hold the boot files and other elements that may require persistence across power cycles. While
not used in this reference design, it is included so this feature can be added later without
modifying the underlying platform.

e Processor JTAG (PJTAG): This is not strictly required by the software, but since we are using a
Xilinx SoC, PJTAG provides additional capabilities not found in fixed SoC systems, allowing the
Zynq PS to reconfigure elements of the Zyng PL at runtime. This facility is not used in this
reference design, but the capability is included for future development.

AVNET” 11 June 5, 2014
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The hard-block processor system at the heart of the Zynq architecture can be configured in Vivado to
satisfy the basic software requirements of our system. Consider this block diagram for the dual ARM
Cortex-A9 cores and hard peripheral system. A checkmark next to each block indicates that the
peripheral is active and will be included in the build. Non-active components are disabled, reducing the
overall power consumed by the system during operation.

I MIO Configuration

f‘ Bark 010 Voltage| LVGMOS 1.8V~ ma— Used for ROM storage
| Search:

. w— = Internet and Intranet

= | erfaces access

ol SRAM/NOR Flash Connect ubiquitous USB

£ NAND Flash
=l- 1/O Peripherals

4 [7] ENETO MIO 16 .. 27 - USB stick, hub and many

5[] ENET 1 i
/ other commercial

9 [¥] UsBo

MIO 28 .. 39 -

devices, such as a mouse,

use 1 peripherals
+- V| SDO MIO 40 .. 45 - .
g * Micro SDHC card
UARTQ
Modem signals
+ [V] UART 1 MIO 48 .. 49 - € Serial communications
3 I2C0
1 12C1
- | SPIO
¥ SPI1
£ CAND
! CAN 1
+- GPIO

+- Application Processor Unit
=|- Programmable Logic Test and Debug

+ TRACE

Processor JTAG

v| PITAG EMIO -

N

Figure 7 — MIO for PS Peripherals for Ubuntu

The system elements included above will be common to many processor-based designs. Not shown in
the diagram above is the configuration of the Hardware Timer, which is selected in the Clock
Configurations panel rather than the MIO Configurations. Although these peripherals are sufficient for
many processor designs, in order to communicate with the on-board HDMI transmitter and audio codec,
we require further custom peripherals within the FPGA fabric. This is where the flexibility of the FPGA
comes to the forefront.

The processor system communicates with PL peripherals using the Advanced eXtensible Interface (AXI)
architecture, while third party peripherals may each have their own communications protocols
depending on the device and its purpose. In order to convert data formats from AXI to the device
specific architectures, we must to instantiate custom IP in the FPGA fabric that will act as a translator
between the processor system and each device function.
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1. HDMI: The processor system has access to the 1°C bus via a Xilinx AXI_IIC controller built in the
PL. This AXI_IIC communicates with the HDMI transmitter and configures it for operation.
However, we have not yet addressed the actual video and audio signals necessary to activate
the HDMI monitor. To do this, we need to be able to send streams of data to the transmitter in
a format it recognizes.

a. axi_hdmi_core: Custom IP provided by Analog Devices to provide a bridge between the
Zyng-7000 All Programmable SoC and the ADV7511 HDMI transmitter chip for 16-bit
color data. This IP provides control information to the chip to process the video stream
arriving over VDMA.

b. axi_spdif_tx_core: Custom IP provided by Analog Devices to provide a path for
transmitting HDMI audio signals from the Zyng-7000 All Programmable SoC to the
ADV7511 HDMI transmitter chip. See Stereo Audio below for a description.

c. axi_hdmi_dma: Custom IP provided by Analog Devices to provide a path between DDR
and the HDMI ADV7511 transmitter chip to move HDMI video data. This DMA engine
offloads the details of maintaining a stream of video output from the Zynq processor
cores. Access to the processor system is provided through the S_AXI_HPO interface.

2. Stereo Audio: Audio signals, like video, create data streams that are best suited to transmission
in the hardware, relieving the processor system from managing the transfers. This means that
we need to include additional Direct Memory Access engines in our design, which can be
programmed by the processor to move the audio data without constant involvement of the
CPUs. We could instantiate the DMA engines in the PL fabric, but in the case of a Zynqg All
Programmable SoC, we have a hard-block containing 4 PL330 DMA engines that can be
individually activated and configured. We will need to use three of these blocks combined with
the following IP to route the data to/from their target devices via the S_AXI_HP2 interface.

a. axi_spdif_tx_core: S/PDIF stands for Sony/Philips Digital Interconnect Format. This
connects via DMA controller Interface 0 to the HDMI transmitter for transmission of
HDMI audio. The transmitter chip handles the details of time-multiplexing the video
and audio signals onto the HDMI output lines for transmission to the display device.

b. axi_i2s_adi: Integrated Interchip Sound, an electrical serial bus interface standard used
for connecting digital audio devices. This IP connects DMA interfaces 1 and 2 to the
Analog Devices ADAU1761 audio codec, one for stereo output to headphones or line-
out jacks and the second for stereo input via the microphone or line-in jacks.

3. CLOCK

a. sys_audio_clkgen: This block takes the 200 MHz FCLK_CLK1 from the PS as an input
and generates a 20 MHz clock output that is used as an input to axi_i2s_adi,
axi_spdif_tx_core, and externally to the ADAU1761 MCLK input.

b. axi_hdmi_clkgen: This block takes the 200 MHz FCLK_CLK1 from the PS as an input and
generates a 148.6 MHz clock output that is used as an input to the axi_hdmi_core.
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a. axi_iic_main: Provides the connection between the processor and an I[IC multiplexer
which then connects to the ADV7511 and ADAU1761 I°C peripherals.

b. sys_i2c_mixer: Since axi_iic_main only has a single IIC port, an external multiplexer is
required to connect multiple external IIC peripherals. The sys_i2C_mixer multiplexes the
IIC ports of both the ADV7511 and the ADAU1761 back to the axi_iic_main IIC controller
in the Zynq PL.

5. Miscellaneous

a. sys_logic_inv: This is a simple inverter that inverts the low-asserted Over-Current (OCn)
signal coming from the USB VBUS switch (TPS2051B) and connects to the high-asserted
Zynq PS USBO peripheral controller signal USBO_VBUS_ PWRFAULT. With this inverter in
place, if the TPS2051B detects an over-current situation for a USB device, then the
PWRFAULT signal will be asserted.

6. Interrupts

a. sys_concat_intc: This block concatenates multiple interrupts from axi_hdmi_core,
axi_iic_main, and axi_iic_fmc and then connects to the interrupt input on the Zynq PS.

7. Interconnects

a. axi_cpu_interconnect: This is an AXI bridge component built into the PL, with a single
AXI Slave connection back to an AXI Master on the PS (M_AXI_GPO0), bridging to 7
downstream Master AXI ports. The interconnect peripherals are needed to connect AXI-
compatible IP to the PS via one of the High Performance or General Purpose interface
channels. The decision on how many peripherals to attach to a single interconnect is
determined by the available bandwidth. This interconnect block is attached to the
M_AXI_GPO port, which allows the PS to act as the master and the PL peripherals as
slaves. All of the peripherals in the system except for video data are relatively low
bandwidth and therefore all connected via this bridge. Those low-bandwidth peripherals
include

i. axi_iic_main
ii. axi_iic_fmc
iii. axi_hdmi_clkgen
iv. axi_hdmi_core (control only)
v. axi_hdmi_dma (control only)
vi. axi_spdif _tx_core
vii. axi_i2s_adi.

b. axi_hdmi_interconnect: The high bandwidth consumer in this design is the HDMI
output, so this interconnect is dedicated to the VDMA engine that transports the video
data signals to the HDMI transmitter. The connection to the PS is made via the high
performance S_AXI_HPO port.
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For information on the channels of communication available between the PS and PL sides of the
Zynq SoC, consult the Xilinx Zyng 7000 All Programmable SoC Technical Reference Manual (UG585).
For quick reference, the figure below provides a high-level synopsis of the available interfaces.

2.6 PS—PL AXI Interfaces

The PS side of the AXI interfaces are based on the AXI 3 interface specification. Each interface
consists of multiple AXI channels. The interfaces are summarized in Table 2-6. Over a thousand
signals are used to implement these nine PL AXI interfaces.

Note: The PL level shifters must be enabled via LVL_SHFTR_EN before PL logic communication can
occur, refer to section 2.7.1 Clocks and Resets.

Table 2-6: PL AX| Interfaces

Interface _— .
Name Interface Description Master | Slave signals
M_AXI_GPO e e (AXL_GP) Ps PL Chapter 5, Interconnect haz a
neral Purpose A section to describe each of these
M_AXI GP1 Ps PL inberfaces.
S _AXI GPO FL Ps The AXI signals are listed
S AX GPL General Purpase (AX]_GP) PL ps individually in section 5.6 P5-PL
AX] Interface Signals.
Accelerator Coherency Port, The AXI_ACP interface is also
SAXLACP cache-coherent transaction (ACP) FL P dezcribed in multiple places in
< A% HPO PL P Chapter 3, Application
- - High Performance ports (AXI_HP) with Processing Unit, including section
S ANI HPL read/write FIFOs and two dedicated PL ps 3.5.1 PL Co-processing
memory ports on DDR controller and Interfaces.
S_AXI_HP2 PL Ps :
i a path to the OCM. The AX]_HP The PS interconnect is shown in
€ AX] HP2 interfaces are known also as AFL PL ps Figure 5-1.

Figure 8 — Zynq PS/PS AXI Interfaces
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Hardware Design Block Diagram

The following figure shows a high-level block diagram of the hardware design.

HDMI
AXI_HPO (Core, DMA, Interconnect, Clock
generation)

SPDIF

AXI_GPO Audio Clock

HDMI DMA
1IC Combo
IIC FMC

Interrupt
Controller

System
Reset

Zynq

Figure 9 - ZedBoard Hardware Design Block Diagram
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Create the Hardware Platform

This section provides the step by step procedure to create a Vivado Design Suite project from source,
and subsequently build the design files and export the hardware platform to an SDK project. If you
would rather not work with the hardware tools, you may skip to Create the SDK Workspace and use the
SDK archive from the Supplied Files.

Create and Build the Vivado Hardware Project

1. Use Windows Explorer to create a new, empty directory named vivado. You may create this
directory anywhere, but in example it is located at:

C:\ZedBoard_V2013_4\HDMI\vivado

Caution: When choosing your own path in Windows, use caution in the path length as all files in
the project hierarchy must fit within the Windows OS limitation of 260 characters. See
http://www.xilinx.com/support/answers/52787.html.

In this example, the target directory shown above was mapped to Windows Drive Letter Y:/.

2. From the Supplied Files, copy the contents of the vivado directory to the new empty vivado
directory you just created.

Organize « Include in library - Burn MNew folder
5 | -
» B Videos & Mame Date modified Type
W library 26/05/2014 9:58 AM  File folder
->Q% Homegroup ! Sy s
| projects 26/05/2014 9:58 AM  File folder
2] build.tel 24/05/2014 9:32 AM  TCL File

Figure 10 - Initial Mapped Vivado Directory
3. From the Windows Start button, launch the Vivado Tcl Shell.

Windows Start | All Programs | Xilinx Design Tools | Vivado 2013.4 | Vivado 2013.4 Tcl Shell

. Xilinx Design Tools _ i
v
£ XilinxInformation Center I8 Vivado 20134 Tcl Shell - CAXilins\Vivado\2013.4\\binkvivado.bat -mode td‘élﬁlg
. DocMav p
. . perescserese Uivado v2B013.4 <64-hitd =
. ISE Design Suite 14.1 soece SU Build 353583 on Mon Dec 9 17:49:1% MST 2013 E
Lab Tools14.7 sxx% [P Build 288876 on Mon Dec 2 12:38:17 MST 2813 b
: ' % Copyright 1986-1999. 28A1-26813 Xilinx. Inc. A1l Rights Reserved.
J Vivade 20121
. fittempting to get a license: Implementation W
. Vivado 2013.2 eature availahle: Implementation
. oading parts and site information from C:rHilinxsUivado-2813.4-datasparts-arch.
J Vivade 2013.3 ml I
Vivado 2013.4 arsing RTL primitives file [C:r/XilinxsUivador2013.4- datarparts xilinx rtl- prims
: = = rtl_prims.xmnll
B Vivado 2013.4 Tcl Shell T inished parsing RTL primitives file [C:rXilinxsVivado-20813.4-/datasparts/xilinx/ I
= t1lsprimssrtl_prims . xml]
44 Vivado 20134 ivadox 1

Figure 11 - Launch the Vivado Tcl Shell
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4. Inthe Vivado Tcl Shell, change to the vivado directory (or the mapped drive), then execute the
Tcl script build.tcl to create and build the hardware platform.

cdY:/
source ./build.tcl

ivadoy cd Y=
ivado¥ source .sbuild.tcl

Figure 12 - Run the Tcl Build Script

The Tcl script will generate the Vivado project, synthesize and implement the source files and
generate a bitstream that can be imported into an SDK project in the next section.

Import the Hardware Platform into the SDK

1. Launch the Xilinx SDK 2013.4 and open a new, blank workspace. This can be done in any
available folder on your host, with the caveat that there can be no spaces in the pathname. For
this example, the path selected is C:\ZedBoard_v2013_4\SDK_WS. Click the OK button.

[ @ Workspace Launcher ﬁw

Select a workspace

Kilinx SDK stores your projects in a folder called a werkspace.
Choose a workspace folder to use for this session.

Workspace:  C:\ZedBoard v2013_4\HDMI\SDK_WS -

Use this as the default and do not ask again

| QK | | Cancel

Figure 13 — SDK Workspace Path

2. Close the Welcome screen. From the main menu, select File -> New -> Project. Expand the
Xilinx entry, select Hardware Platform Specification and click the Next button.

@ New Project o x

Select a wizard —

Wizards:
type filter text

= General
(= C/C++
a = Kilime
(éll Application Project
Wil Board Support Package
iz Hardware Platform Specification

@:‘ < Bac Mesxt = Finish Cancel

Figure 14 — Create New Hardware Project
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3. Name the project hw_platform_0. This is critical since the BSP and applications to be
imported later map to this name. For the Target Hardware Specification, browse to the
directory containing the hardware platform source generated by the Tcl script. For the
mapped directory Y:/ used in this example, the source files are created in:

Y:\projects\adv7511\zed\adv7511_zed.sdk\SDK\SDK_Export\hw

Select the system.xml file and click the Open button to populate the Target Hardware
Specification.

(& ew Hardware Fraject . jo— lnl—r!‘i"ﬂ

|
Mew Hardware Project

Create 5 new Hardware Project.

:

hw_platform_0 e

Frogect naened ve_platfoem 0

o+ Uk default location

LedBosrd

Tanget Hardware Specification

Prewide the path to the handware specification file exporied from Project Mavigator or XPS oo Vivedo or IPL
This file usually resides in SDICSDK_Exporthew folder relstive to the XP5Avado project location.
The specification file snd sssocisted bitstream content will be copied into the worapace.

W projeets sch TELL e sk TS _ped ek SDAD SO _Export'bra it el
¥ Bagiream and EMM Files

Figure 15 — Select the Hardware Platform

4. Click the Finish button to import the hardware platform.

,

File Edit Source Refactor Mavigate Search Run  Project Xilinx Tools Window Help

§ - | &~ & ~ B rEvg-@ H-O-Q v

% - -

i |

[
4
4

i Project Explorer &2 = B || g systemaml 2

&= =
BE5|Y hw_platform_0 Hardware Platform Specii
4 B hw_platform_0

[€] psT_init.c Design Information
ps7_init.h ]
@ ps7_inithtml Target FPGA Device: 72020

Created With: Vivado 20134

|2 psT_init.tcl
Created On: Mon May 26 10:20:25 2014

@ ps7_summary.html

|=| system_top.bit
Address Map for processor ps/_cortexa9_0

|4 system.xml
Figure 16 — Imported Hardware Platform

The SDK workspace is now ready for application projects. You have already created an
SDK workspace, so you may skip to Step 3 in the next section.
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Create the SDK Workspace

This section provides the steps for importing SDK projects from Supplied Files, and running the vHDMI
application on ZedBoard using a basic download procedure. The vHDMI application project contains
custom software to exercise the HDMI transmitter from Analog Devices, which cannot be generated
from the standard application templates included in the SDK.

This document assumes a basic familiarity with the operation and features of the Xilinx SDK. If you are
unfamiliar with this tool, it is recommended that you consult the Avnet Speedway: Developing Zynq
Software with the Xilinx SDK (see Appendix I: Where to Get More Information).

Import the SDK Projects

1. Launch the Xilinx SDK 2013.4 and open a new, blank workspace. This can be done in any
available folder on your host, with the caveat that there can be no spaces in the pathname. For
this example, the path selected is C:\ZedBoard_v2013_4\SDK_WS. Click the OK button.

[ @ Workspace Launcher [-i&-f

Select a workspace

Kilinx SDK stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace:  C\ZedBoard v2013_4\HDMI\SDK_WS -

Use this as the default and do not ask again

| oK | | Cancel

Figure 17 — SDK Workspace Path

2. Close the Welcome screen.
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3. From the main menu, select File -> Import. Expand the General entry, select Existing Projects
into Workspace and click the Next button.

o
EER =R
Select \‘
Create new projects from an archive file or directory. E 5
Select an import source:
type filter text
4 (= General -
[, Archive File
= Existing Projects into Workspace
[, File System o
o)
@ < Bach Next > Foar

Figure 18 — Import Archive File

4. Click the radio button for Select archive file. Browse to the SDK_project _archive folder in your
Supplied Files installation and select the compressed workspace file.

<Installation folder>\SDK_project_archive\zed_hdmi_sdk_ws.zip

Import -

Import Projects

]

Select a directory to search for existing Eclipse projects.

(7) Select root directory: Browse...
@ Selectarchive file:  C:\ZedBoard_v2013_4\HDMN\ZedBoard_HDMI_Ref_Des_2013_4\SDK_project_archive\zed_hdmi_sdk_ws.zip
Projects:
hw_platferm_0 (hw_platform_0) Select All
standalone_bsp (standalone_bsp)
vHDMI (vHDMI) Deselect All
b
zyng_fshl_bsp (zynq_fsbl_bsp)

Copy projects into workspace
Working sets
[ Add project to working sets

Select...

@ Next > [ Fimish || Concel
Figure 19 — Select SDK Projects from Archive |

All projects should be selected by default. If they are not, click the Select All button®. Click the
Finish button to import the projects to your new workspace. All projects will compile
automatically, and should do so with no errors. Click the Console tab to view the compilation
progress.

* If you built the hardware platform with the Tcl script in Create the Hardware Platform, you will already have the
hw_platform_0 project and it will not be selectable here.
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5. Your workspace will now contain the following projects:

a. hw_platform_0: The elements of the Vivado hardware platform exported to the
original SDK workspace, on which the bare metal (standalone) BSP is based.

b. standalone_bsp: The board support package required by all non-0S applications for the
hardware platform included in this workspace. This BSP is automatically generated by
the SDK when the first application project is created, following a successful export of the
hardware platform from Vivado.

c. VHDMI: The bare metal HDMI demonstration/test application, provided by Analog
Devices. See Appendix I: Where to Get More Information.

d. zyng_fsbl: The first stage boot loader application for this hardware platform. The first
stage bootloader ELF is one of three files (also the bitstream and application ELF) used
to create a boot.bin file executed from the SD card on power-up. This application can be
automatically generated using the application template provided within the SDK.

e. zyng_fsbl_bsp: The board support package for the first stage bootloader. Beginning
with the 2013.4 version of the SDK, the FSBL BSP requires the inclusion of a FAT file
system when booting from an SD card. This is the only difference between the FSBL
BSP and the bare metal BSP. The FSBL BSP is automatically generated when the FSBL
application is created.

Run/Debug the vHDMI Application via JTAG

The procedure for using JTAG to download applications to the board for the purpose of execution or
debugging is described briefly in this section. This example uses the vHDMI application, but the
download procedure is similar for all application projects. Ensure you have the HDMI cable connected
between the target and your monitor, and that the monitor is switched on.

Your hardware should be connected as described in Setting up the ZedBoard Development Kit and the
mode jumpers should all be in the off position.

Ensure you have a USB cable connected between the host computer and the JTAG port on the target.
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1. Apply power to ZedBoard. Program the SoC by selecting the 22 icon from the SDK task bar
and accepting the default bit stream.

Program FPGA

Program FPGA
Specify the bitstream and the ELF files that reside in BRAM memory

Hardware Configuration

Hardware Specification: CASDK_WS\hw_platform_0systern xml

Bitstream:  system_top.bit

Software Configuration

Processor ELF File to Initialize in Block RAM

P

L‘?_,' | Program l l Cancel

Figure 20 — Bitstream Selection

2. Select the Terminal 1 tab, and access the Settings panel by clicking on the B icon. Select the
Connection Type as Serial, the Baud Rate as 115200, and select the Port that was automatically
used by the Cypress USB-to-UART driver when the FPGA was loaded in the previous step. In
this example, the port is COMS5. Click the OK button.

[ Terminal Settings @

View Settings:

View Title:  Terminal 1

Encoding: 150-8858-1

4

Connection Type:

Flow Control: | None

Serial -
Settings:

Port: COMS v

Baud Rate:
Data Bits:
Stop Bits:

Timeout (sec): 5

: [ ok || Concel ]I

Figure 21 — Set the SDK Terminal Parameters
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3. Inthe Project Explorer tab of the SDK, right-click on the vHDMI project and select Run As ->
Launch on Hardware (GDB). In a few seconds the application will download and the output will
appear in the Terminal 1 tab. You may need to select the Terminal 1 tab to switch from the
Console®, or you can drag the Terminal tab up to the main source panel in the SDK so that it is
always on top.

B Terminal1 &2 2B I ._.El - - =8
Serial: (COMS, 115200, 8, 1, Mone, Mone - COMNECTED) - Encoding: (ISO-8859-1)

ADI HDMI Trasmitter Application Ver R1.1.1
HDMI-TX: ADVI511 Rev @xl2

To change the wvideo resclution press:
‘@' - G48x480; '1' - BEEx6@R; '2' - 1824x763; '3’ - 12B@x72@
'4' - 1368x768; 'S5 - 1608@x908; '6' - 1928x103@.

Mute audio and video.

APP: Driver Enabled

HPD changed to HI

MSEN changed to HI

APP: Changed system mode to Transmitter

Un-mute audio and video.

Figure 22 — vHDMI Test Output in SDK Terminal

The output should be identical to the vHDMI Test executed from the SD card in the
demonstration section®. You can create a boot image using the projects included in this
workspace and the Xilinx Tools -> Create Zyng Boot Image menu item. If you need instructions
for this, consult the Avnet Developing Zynq Software with the Xilinx SDK Speedway.

4. If you would prefer to debug the application, right-click vHDMI and select Debug As -> Debug
Configurations. In the Debug Configurations panel, select the Xilinx C/C++ application (System

s

Debugger) and click the icon at the upper left to create a new configuration.

Create, manage, and run configurations

Debug a program using System Debugger.

= —+l
REER . | R

type filter text

[T] C/C++ Application
[E] C/C++ Attach to Application
[©] C/C++ Postmortem Debugger
[€] C/C++ Remote Application
= Launch Group
i: Remote ARM Linux Application
Fﬁ Target Communication Framewaork
4 &, Xilinx C/C++ application (GDB)
£ HDMLelf
4 .?EF X'ilinx C/C++ application (System Debugger)
£ vHDMI Debug

TEF

Figure 23 — Create New System Debugger Configuration

Y you wish, you may use a serial terminal program such as Tera Term instead of the SDK Terminal tab.
> If you do not see any output in your serial terminal, try toggling the connection and run the application again.
Also ensure you have connected to the correct COM port.
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5. Click the Debug button. Click Yes to confirm a switch to the Debug Perspective®. The
Application will launch in the symbolic debugger and stop automatically at the first executable
statement. You may use the standard debug controls to operate the application in debug
mode. If you need instructions on how to do this, please reference the Avnet Developing Zynq
Software with the Xilinx SDK Speedway.

Serial output will be available under the Terminal 1 tab.

Debug - vHDMY/sr/maine - Xiinx SOK T ™™

File Edit Source Refactor Navigate Search Run  Project  Xilink Tools Window Help

B4 v @~~~  #| = o3 ki P - ) PN
:#;iDEbugE@. |i'=5>

P '?I::F vHDMI Debug (50K Hardware Server)
xciz020
a % APU
4 g% ARM Cortex-A9 MPCore #0 (Breakpoint)
= 00010134 main(): ../src/main.c, line 151
00010658 ¢ _start(): xil-crtd.5, line 149

> o ARM Cortex-A9 MPCore #1 (Suspended)

€ main.c &

[@return Returns @.

= int main()

UINT32 StartCount;

MajorRev =1;
MinorRev = 1;
RcRewv = 1;
DriverEnable = TRUE;
LastEnable = FALSE;

Xil_ICacheEnable();
Xil_DCacheEnable();

#ifdef XPAR_AXI_IIC_@ BASEADDR
HAL_PlatformInit(XPAR_AXI_IIC @ BASEADDR, /* Perform any required platform init */
XPAR_SCUTIMER DEVICE_ID, /* including hardware reset to HDMI devices */
XPAR_SCUGIC SINGLE DEVICE ID,
XPAR_SCUTIMER INTR);

Figu'l"-e_ 24- Applicaiic;n bebug

This concludes the ZedBoard Bare Metal HDMI Reference Design. You may close all open applications
and turn off power to your ZedBoard.

® HINT: Click the checkbox to remember your decision to avoid the pop-up box in the future.
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Appendix I: Where to Get More Information
ZedBoard.org

ZedBoard documentation page
http://www.zedboard.org/documentation/1521

ZedBoard reference designs and tutorials
http://www.zedboard.org/design/1521/11

Avnet Speedway: Developing Zyng Software with the Xilinx SDK
http://www.zedboard.org/support/trainings-and-videos

Ubuntu on the Zyng-7000 SoC Tutorial
http://www.zedboard.org/design/1521/11

ZedBoard Forum Support
http://www.zedboard.org/forums/zedboard-hardware-design

ADI

ADV7511 Product Page
http://www.analog.com/en/audiovideo-products/analoghdmidvi-
interfaces/adv7511/products/product.html

ADAU1761 Product Page
http://www.analog.com/en/audiovideo-products/audio-signal-
processors/adaul761/products/product.html

Wiki Instruction page

http://wiki.analog.com/resources/fpga/docs/hdl
http://wiki.analog.com/resources/fpga/docs/hdl/vivado
http://wiki.analog.com/resources/fpga/xilinx/kc705/adv7511 (bare metal software)

ADI HDL Reference Designs HDL User Guide
http://wiki.analog.com/resources/fpga/docs/hdl/github

ADI Support
http://ez.analog.com/community/fpga

ADV7511 Xilinx Evaluation Boards Reference Designs (ZedBoard)
http://wiki.analog.com/resources/fpga/xilinx/kc705/adv7511
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Xilinx Website

Xilinx Design Tools Installation and Licensing Guide
http://www.xilinx.com/support/documentation/sw _manuals/xilinx2013 4/ug973-vivado-release-notes-
install-license.pdf

Zynq
http://www.xilinx.com/products/silicon-devices/soc/zyng-7000/index.htm

Xilinx Silicon and Tools Forum Support
http://forums.xilinx.com/

Other Internet Resources
http://www.hdmi.org/
http://en.wikipedia.org/wiki/HDMI
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